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1 Preface 
 

1.1 Preface and Scope 
 
This document is intended to be a technical description and design document 
for use by technical people. 
 

1.2 Disclaimer 
 
This document is subject to change without notification and will not 
comprehensively cover the issues encountered in any customer situation. It 
should only be used in conjunction with the product literature accompanying 
the J2EE products from IBM and SAP. 
 
The information contained in this document has not been submitted to any 
formal IBM test and is distributed AS IS. 
 

1.3 Scope  
 
This document is a guide containing a sample that shows how to develop a 
JSF portlet with IBM Rational Application Developer Version 7. The portlet will 
be able to access an SAP system and get its containing data using service 
data objects (SDO). Furthermore the received data will be visualized within 
the Portlet using the Java Server Faces (JSF) technology. 
The guide is illustrated by screen captures so that you can reproduce it step 
by step. 
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2 System prerequisites 
 

2.1 IBM Rational Application Developer V7 
 
The IBM Rational Application Developer V7 must be properly installed in order 
to create SAP content-based JSF-Portlets.  
You also need to install the SAP JAVA Connector (SAP - JCo) to connect to a 
SAP back-end system from Rational Application Developer. You should use 
the latest version of the SAP-JCo. 

2.2 WebSphere Portal and Application Server 
 
To use the SAP-Mediator functions of the SDO, you must have properly 
installed WebSphere Portal Server V6, which also assumes a proper 
installation of the WebSphere Application Server.  Moreover, note that the 
WebSphere Application Server is also SAP-JCo enabled. You should use at 
least version 2.1.1 of the SAP-JCo. 
This sample uses the integrated WebSphere test-environment of the IBM 
Rational Application Developer. 

2.3 SAP/R3 
 
You must be able to access a SAP/R3 system and have the appropriated 
rights to access the BAPI you want to call.  

2.4 SAP JCo 
 
The SAP Java Connector is a free Java library to connect to the different SAP 
back end systems using Java code to run BAPI calls. 
It can be downloaded at http://service.sap.com in the current version 2.1.8 . 
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3 Introduction to JSF and SDO 
Java Server Faces (JSF) is a framework that simplifies building user 
interfaces for Web applications. The combination of the JSF technology and 
the tools provided by Rational Application Developer affords developers of 
differing skill levels the ability to achieve the promises of rapid Web 
development. 
This section provides an overview examining three aspects of JSF: 

• JSF features and benefits 
• JSF application architecture 
• IBM Rational Application Developer support for JSF 

 

3.1 JSF features and benefits 

3.1.1 JSF standards-based Web application framework 
Java Server Faces technology is the result of the Java Community process 
JSR-127 and evolved from Struts. The original author of Struts (Craig 
McClanahan) is a participating author of the JSF specification. JSF addresses 
more of the Model-View-Controller pattern than Struts, in that it more strongly 
addresses the View or presentation layer though UI components, and 
addresses the Model through Managed Beans. Although JSF is an emerging 
technology and will likely become a dominant standard, like Struts is today. 
JSF is targeted at Web developers with little knowledge of Java by eliminating 
much of the hand coding involved in integrating Web applications with back-
end systems. 

3.1.2 Event driven architecture 
JSF provides server-side rich UI components that respond to client events. 

3.1.3 User interface development 
UI components are decoupled from its rendering. This allows for other 
technologies such as WML to be used (for example, mobile devices). 
JSF allows direct binding of user interface (UI) components to model data. 
Developers can use extensive libraries of ready-made UI components that 
provide both basic and advanced Web functionality. 

3.1.4 Session and object management 
JSF manages designated model data objects by handling their initialization, 
persistence over the request cycle and cleanup. 

3.1.5 Validation and error feedback 
JSF allows direct binding of reusable validators to UI components. The 
framework also provides a queue mechanism to simplify error and message 
feedback to the application user. These messages can be associated with 
specific UI components. 
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3.1.6 Internationalization 
JSF provides tools for internationalizing Web applications, supporting number, 
currency, time, and date formatting, and externalizing of UI strings. 

3.2 JSF application architecture 
The JSF application architecture can be easily extended in a variety of ways 
to suit the requirements of your particular application. You can develop 
custom components, renderers, validators, and other JSF objects and register 
them with the JSF runtime. 
 

• JSF page JSPs are built from JSF components, where each 
component is represented by a server-side class. 

• Faces Servlet - One Servlet (FacesServlet) controls the execution flow. 
• Configuration file - An XML file (faces-config.xml) that contains the 

navigation rules between the JSPs, validators, and managed beans. 
• Tag libraries - The JSF components are implemented in tag libraries. 
• Validators - Java classes to validate the content of JSF components, 

for example, to validate user input. 
• Managed beans - JavaBeans defined in the configuration file to hold 

the data from JSF components. Managed beans represent the data 
model and are passed between business logic and user interface. JSF 
moves the data between managed beans and user interface 
components. 

• Events - Java code that is run in the server for events (for example, a 
push button). Event handling is used to pass managed beans to 
business logic. 

3.3 IBM Rational Application Developer support for JSF 
IBM Rational Application Developer V7 includes several features for building 
highly functional Web applications. It includes full support for less skilled 
developers create drag-and-drop Web applications. 
Rational Application Developer includes the following support and tools for 
JSF Web application development: 

• Visual page layout of JSF components using a page designer 
• Built-in component property editor 
• Built-in tools to simplify and automate event handling 
• Built-in tools simplify page navigation 
• Page navigation is defined declaratively 
• Automatic code generation for data validation, formatting and create-

read-update-delete functions for data access. 
• Relational database support 
• EJB support 
• Web services support 
• Data abstraction objects for easy data connectivity (SDO) 
• Data objects can be bound easily to user interface components 
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3.4 Service data objects (SDO) 

Service data objects are designed to simplify and unify the way in which 
applications handle data. Using SDO, application programmers can uniformly 
access and manipulate data from heterogeneous data sources, including 
relational databases, XML data sources, Web services, and enterprise 
information systems.  

SDO is based on the concept of disconnected data graphs. A data graph is a 
collection of tree-structured or graph-structured data objects. Under the 
disconnected data graphs architecture, a client retrieves a data graph from a 
data source, mutates the data graph, and can then apply the data graph 
changes back to the data source. 

The task of connecting applications to data sources is performed by data 
mediator services. Client applications query a data mediator service and get a 
data graph in response. Client applications send an updated data graph to a 
data mediator service to have the updates applied to the original data source. 
This architecture allows applications to deal principally with data graphs and 
data objects. 

SDO enables both a static (or strongly typed) programming model and a 
dynamic (or loosely typed) programming model. This enables a simple 
programming model without sacrificing the dynamic model needed by tools 
and frameworks.  

SDO also provides a metadata API, which allows applications, tools, and 
frameworks to introspect the data model for a data graph. The SDO metadata 
API unifies data-source-specific metadata APIs to enable applications to 
handle data from heterogeneous data sources in a uniform way.  
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4 Creating the sample with Rational Application Developer  

4.1 Description 
The presented sample is able to show a page with the companies of an SAP 
system in a simple table.  
 

 
 
In the following pages, you will see how to develop the project and its needed 
components. First you will see how to create a new portlet project with 
Rational Application Developer, then how to initialize the Portal Server where 
the final Project will be deployed. Finally you will see how to create the SDO 
to integrate the data of the SAP system with JSF. 
 

4.2 Creating the Portlet Project 
After Rational Application Developer has been started, use File → New → 
Project and select the Portlet Project Wizard as shown in the following figure 
and click Next. 

 

Figure 1: Overview of the final sample page 
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Now you have to specify the name and basic settings of the portlet project. 
Make sure that the selected target runtime is the WebSphere Portal V6.0 
server and that the Portlet API is the JSF 168 Portlet. Furthermore the type of 
the automatically created Portlet must be a Faces Portlet. Proceed by clicking 
on Next. 

 

Figure 2: Select the Portlet Project Wizard 
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The next window provides general settings like content types and locale-
specific information. There is no need to make any changes for this sample, 
so continue with Next. 

 

Figure 3: Specification of the name and the settings 
of the Portlet Project 
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The next screen lets you configure the advanced settings, but that is not 
needed in this case. Finalize the portlet project creation by clicking Finish. 

 
The Portlet Project is now located in the Project Explorer on the left side of the 
IBM Rational Application Developer desktop. The central window shows the 
Web diagram editor which is not needed any more and can be closed. 

 

Figure 4: General settings of the Portlet 
Project 

 

Figure 5: Advanced settings of the 
Portlet Project 
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Make sure that the Web perspective is selected (menu: Window → Open 
Perspective) to be able to follow the further instructions. 

 

 

 

 

Figure 6: IBM Rational Application Developer desktop with Web perspective 
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4.3 Creating the Portal Server 
To be able to run the created portlet project, you need to create a Portal 
Server where the Portlet can be deployed. Change to the server tab in the 
middle bottom panel. Right-click, and select New, then Server. 
 

 
For this sample, use the WebSphere Portal Server V6.0. Specify the host 
name and type of the portal server and click on Next. 
 

 

Figure 7: Create a new Portal Server 
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Afterwards you can change the server connection type and port but you can 
also keep the default values in this case. Specify user ID and password for 
the server and click Next. 
 

 

Figure 8: Specify the Portal Server 
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Specify the settings of the portal and set again the user ID and password so 
that you are able to start and stop the Portal Server directly from IBM Rational 
Application Developer. Click Next. 

 
The settings in the next panel do not need to be changed. Click Next. 

 

Figure 9: Websphere settings 

 

Figure 10: Websphere Portal settings 
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Now you can select the previously created portlet project and add it to the 
server where it will be deployed. Click Finish to complete the creation of the 
portal server. 

 
The new server is then added to the server tab. 
 

 

Figure 11: Add Portlet Project to the 
server 

 

Figure 12: Server tab with the created server 
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4.4 Creating the JSF Portlet 
The file CompanyListVisualizationView.jsp was automatically created from the 
portlet project wizard. This is the JSF page that should finally show the table 
of companies of the SAP system. 
 

 

4.4.1 Adding the SAP SDO 
First of all delete the default page view Place content here. As you are going 
to display data of the SAP System, you need an SDO that is able to access 
the SAP server and provide its content. Select the Data menu from the palette 
on the right side of the desktop. Now drag the entry SAP RFM in the design 
view of the CompanyListDetail.jsp file and drop it there. 

 

Figure 13: View of the IBM Rational Application Developer desktop after creating the portlet 
project and the portal server 



IBM WebSphere SAP Technology Team   

Rational Application 
Developer V7 

SAP integration sample Page 18 

   
 
    
 

 
After releasing the mouse button the SDO object wizard appears where you 
have to enter the name of the SDO. Click Next. 
 

 

Figure 14: Adding the SAP SDO to the Portlet 
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In the next panel, define the parameters for the SAP server connection. Make 
sure that all fields have values filled in; otherwise it could lead to a runtime 
exception. 

 

Figure 15: SDO Object Wizard 
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After the settings have been made the connection shows up in the Browse 
Connections window. Click OK to proceed with the creation of the SDO. 

 

 

Figure 16: Set up the SAP server connection 

 

Figure 17: Completed connection 
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Now it is possible to search for business objects in the SAP system. For this 
sample the BAPI BAPI_COMPANY_GETLIST is needed which can be found 
using the search by name. 

 
After clicking on Next the import and export parameters are shown; all should 
be selected. 
 

 

Figure 18: Select the BAPI 
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The next panel lets you define pre- and post- functions that are needed for 
some SAP Business Objects. In this case none of the functions is required so 
that the SDO creation can be finished. 

 

Figure 19: Select the BAPI parameters 
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The created SDO appears in the Services menu of the Page Data panel in the 
bottom left corner of the Rational Application Developer desktop. 

 

 

Figure 20: Pre and post function configuration 

 

Figure 21: SAP SDO in the Page Data view 
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4.4.2 Adding the JSF components 
 
To create the visualization for the company list data, expand the entry 
companyListResult of the SDO. Select the two entries COMPANY and 
NAME1 of the COMPANY_LIST_RESPONSE_BAPI and drag them to the 
design view of the JSF Portlet. 
 

 
 
Drop at the wanted place to insert new controls for the selected data as 
shown by the information box. The following panel appears: 

 

Figure 22: Add the company list attributes to the JSF Portlet 
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Keep the selection “Multi-Column Data Table” because it will create a table 
that dynamically adds a row for each entry in the result set of the SDO. Click 
Finish. 
The design view should now show a table with two columns belonging to the 
selected attributes. 
 

 

Figure 23: Configure the appearance of the attributes 



IBM WebSphere SAP Technology Team   

Rational Application 
Developer V7 

SAP integration sample Page 26 

   
 
    
 

 
The attribute names in the curly brackets indicate that the column body will 
not show a fixed value but the values from the SAP system. Contrary to that 
the column title is a fixed value that should be adapted to a more common 
name. 
In order to change the title of a column you have to click on the output text 
field located in the column header. Then select the properties tab below and 
enter the name into the value field. For this sample change the first column 
title to “Id” and the second to “Name”. 
 
Since the data from the SAP system is needed at the time of page load, it is 
necessary to invoke the appropriate method. For this purpose you have to 
select the hx:scriptCollector as it is shown in Figure 26. 
 

 

Figure 24: View of the table that contains the attributes of the company list 
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Then change to the Quick Edit tab and select the entry Page Load Begin. 
There you can add code that is invoked before the JSP Faces page has been 
rendered. 
Add the line: 
 
doCompanyList(); 
 
which is the method call that retrieves the data from the SAP system so that it 
is accessible through the SAP SDO. 
 

 
 

 

Figure 25: Select the script collector object 

 

Figure 26: Add the java code to initialize the SAP SDO 
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After saving and compiling the project it is ready for the final deployment to 
the server. Open the context menu by right-clicking on the project in the 
Project Explorer. 
 

 
 
Select Run As and then select Run on Server. 
The next panel prompts you to choose the server where you have to select 
the prior created WebSphere Portal Server V6.0. Click Finish and the project 
will be deployed to the server. 
 

 

Figure 27: Deploy the project to the server 
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If the project has been successfully deployed, IBM Rational Application 
Developer automatically opens a browser window that shows the generated 
page containing the visualization of the company list. This should look as 
follows: 
 

Figure 28: Define the target server 
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4.5 Summary 
In this document, you have seen how to create a JSF Portlet with SAP 
integration supported by IBM Rational Application Developer tools. As shown 
by the screen captures, this process is facilitated by various wizards that 
make it easy for developers to access the data of an SAP system and create 
a pleasing visualization from it. 
Because of the automatic support, there is almost no need to write code 
yourself and for this reason, less skilled developers are able to develop very 
fast.

 

Figure 29: Browser window with the final sample page view 
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5 References 
 
There is information available about a prior published document dealing with 
SAP integration using IBM Rational Application Developer 6.0 and Portal V5.1 
Server: 
http://www.ibm.com/developerworks/rational/library/05/607_sasch/ 
 
 
Detailed information on the SDO Java specification request is JSR-235 and 
can be found at: 
http://www.jcp.org/en/jsr/detail?id=235 
 

For more information about the goals and architecture of SDO, see the 
Whitepaper: Next-Generation Data Programming: Service Data Objects at: 
http://ftpna2.bea.com/pub/downloads/commonj/Next-Gen-Data-Programming-Whitepaper.pdf  

 
Detailed information on the JSF specification can be found at: 
http://java.sun.com/j2ee/javaserverfaces/download.html 
 
For more detailed information on JavaServer Faces and Service Data 
Objects and IBM Rational Application Developer 6.0 developing check the 
Redbook:  
Rational Application Developer V6 Programming Guide 
http://www.redbooks.ibm.com 


